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Finding Your Way Around The Software 
 
Rockit is a fully skinnable program, meaning it can take on many shapes and sizes. A skin can have as few controls on it 
as needed (even none), to all of the controls available -- so take your time to check out the different skins we have 
available, to find the one that best suits your style of mixing. For this manual, we will use the default skin that shows up 
selected when you first start Rockit – the DJ-900 skin. We’ve highlighted some areas of the skin so you can see what they 
do. 
 

 
 
 
 

1. Main Menu Section 
On V5 skins, you will generally find 4 menu items at the top left of the skin; File, View, Tools and Help. These 
provide standard functionality in Rockit, much like they do in everyday Windows programs. 
 

2. Waveform/Spectrum Display 
On the DJ-900 skin, the default is to display the spectrum of the song playing. This is a real-time display. You can 
toggle back and forth between spectrum and waveform, by right-clicking over that particular deck, and choose 
Toggle Waveform/Spectrum. 
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3. Deck Display 
On this particular skin, you will see Artist, Title, BPM, Elapsed Time, Remaining Time, Album Art image, and the 
song progress meter. There are many other fields of information we could display, but on this skin, we’ve chosen 
to keep it simple. Remember that all skins can be different, and hide or show various information regarding the 
currently loaded track. You can also easily modify the skin files yourself, to replace, move or show information. 
You will find basic and advanced skinning manuals on our website tutorials page. 
 

4. Deck Transport Controls 
As with the text fields above, Rockit has many controls available for each deck. On this skin, we have the 4 preset 
song buttons, 2 of the FX, Fade In and Out, Waitlist popup, Next song in Waitlist button, EQ knobs, Pitch control 
with center button, and the main transport controls for Stop, Pause and Play. 
 

5. Jog Wheels 
The jog wheels are used to fast forward/rewind a song, and for stutter effects while playing. They work like a 
slider, meaning you don’t move them in a circular motion - you grab the wheel, and move the mouse up or down 
to control them. The EQ knobs work in the same fashion. Some of the skins have a small dot that moves around 
as the knob is moved, or the song is playing. 
 

6. Button Area 
Not really sure what else to call this, but it is just a section of the skin that holds some important buttons. On this 
particular skin, you will find the Master Mixer button, Configuration button, Music Library Manager, Text Output, 
and Video Jukebox buttons. All of these commands are available via standard menu commands, and keyboard 
shortcuts as well, so you could modify the skin to put something else here if you like. 
 

7. Mixer section 
We’ve kept it pretty simple on this skin – you will find level VU meters, volume sliders, crossfader, and the 3 mix 
buttons. The VU meters show input level, not output level. We’ve found that seeing the input level is more intuitive 
for us to gauge how to set the output volume. Just showing you some blinking lights of what is going out doesn’t 
help much, since you can hear it already – but knowing the volume coming from the decoder gives you a better 
opportunity to adjust output levels accordingly. 
 

8. AutoMixer 
The AutoMixer allows you to let Rockit do the mixing for you. It is very useful when playing music for dinner or 
cocktail hour, and in fact, many users run with it for the length of the show. It can be manually overridden even 
while leaving it turned on. On this particular skin, we show the AutoMix On/Off button, Settings button, status 
display, and the AutoMix Waitlist. 
 

9. Navigation Tree/Browser 
This tree allows you to view your music, both in the library, and directly on your computer hard drive. Whatever 
you highlight in this tree, is displayed in the main tracklist # 10 to the right (it doesn’t have to be to the right, but on 
most skins it is). Bear in mind, that the object of the library is to make the program perform faster, and 
automatically categorize your music based upon tag data. It is much faster, and more convenient to look through 
your music using the library display options, then it is to look under My Computer (or Computer depending on 
your OS). So to take advantage of these features, plus our extended search features, load all your music into 
Rockit’s library. 
 
 

10. Main Tracklist 
This is where you will see all your tracks listed, based upon what is selected in the Navigation Tree. The list is 
sortable by clicking on the header of your choice (such as Title, Artist, etc.). To load a song into a deck, either 
drag and drop it, or simply double-click the song (double-clicking loads to the first available deck not playing). 
Many options are available by right-clicking on an item in the list. 
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11. InfoWindow Display 
This little window will display the current album art (if available in the file tag), along with some basic information 
about the file, including comments you may have in the tag. You can toggle this window on or off as needed, by 
right-clicking on the Main Tracklist. 
 

12. Search Results 
This list will display the results of searches using either the Search Library or Search Current List options. As with 
the Main Tracklist, you can either drag and drop songs to a deck, waitlist, or double-click to have load to the next 
available deck. 
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Setting Up Your Music Library 
 
To get the most out of Rockit, you will first want to import your music into our Music Library. The library is simply a 
database listing of your music, and does not copy any files. It does all the leg work of reading the MP3 tag data, 
and keeps all that information in memory when Rockit is running, allowing you to search your music quickly and 
effortlessly, and automatically categorizing based up a number of data types. 
 
When you start Rockit for the first time, the Add Wizard will automatically show, and allow you to add your music 
to the library. You can also access it at any time through the Tools menu, or directly from the Music Library 
Manager screen. 
 
Step 1 - The first screen simply alerts you to the types of files the Wizard will search for, simply click the 
Next button. 
 

 
 
Step 2 – Choosing where to search for music 
 

 
 
You can highlight a main drive (as seen above), to have the Wizard search the entire hard drive, or click the plus 
sign next to the drive, and select a certain folder hierarchy to search through. Whatever you choose, the Wizard 
will search all folders underneath that. If you choose a full drive or folder with a large number of files, this will take 
a few moments. Click Next to begin the search. 
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Step 3 – The Search 
 

 
 
After the search has completed, you will see something similar to the above – the Wizard in our case, found a 
number of MP3 and WAV files. We can click Next, and proceed to the 4th and final step. 
 
 
Step 4 – Adding the Music 
 

 
 
You can choose Add All at this point, to add everything the Wizard has found, and the process of parsing and 
importing into the library will begin. If you have a large number of files, this process can take some time – in our 
case above, with 2758 files, it only took about 1 minute. If you want to add only newly found files, you can choose 
Add Only New Files, and the Wizard will check files against the library as it adds, and only put the new ones in. 
This is generally slower due to the overhead. 
 
The Only add MP3 option, is useful if you keep your music on your main Windows hard drive. Windows keeps a 
large amount of WAV soundbites that it uses for various noises, and most times you will not want those added to 
your music library. Simply check that box, and Rockit will ignore the WAV files it found. 
 
That’s about it, when it has completed, click Finish, and you will be brought back to Rockit’s main screen, and 
your Main Tracklist will refresh with the added songs. 
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Setting Your Sound Card Outputs 
 
Rockit can handle up to 6 sound cards simultaneously, for the most flexibility. Having multiple sound cards allows 
you to split the decks to separate mixer channels, so you can cue off your existing hardware mixer – plus, you can 
also output our audio jukebox to another sound card, and output to a separate system for cocktail music, dinner, 
ceremonies, etc. 
 
If you are using a single output, such as a laptop headphone output jack to your mixer or powered speakers, you 
will have no need to setup your sound cards in Rockit, as it is setup to use the Windows default sound card after 
installation. If you have external sound cards, click the Master Mixer button (or open through the View menu), and 
you will see the following screen: 
 

 
 
In our case above, Deck A is highlighted to the left, and Mains Output is currently set to 0 : Microsoft Sound 
Mapper, which is the Windows Default sound card output. Microsoft Sound Mapper is not a real sound card, it 
simply points to one of the actual devices listed. In our case, it actually points to the Speakers (7-USB Audio 
Codec), which is an external USB sound card. So, we could select either 0 or 1, and get the same results. 2 in our 
list, is the speaker output on our computer itself. The more sound cards you have attached, the more items in 
your list. 
 
If we wanted to, we could set Deck A to output Mains to the USB sound card, then click Deck B on the left, and 
set its Mains out to the built in sound card (#2), and run each into a separate mixer channel. 
 
There are many ways to setup the output configuration, so please see the Sample Setups page on our website for 
more detailed information. 
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Loading and Playing Songs 
 
Rockit has a multitude of ways to load and play music. The easiest way is to simply double-click a song in the 
Main Tracklist area, and it will load into the first available deck that is not currently playing a song. You can also 
drag and drop a song from any list directly onto the deck you want. 
 
If you right-click a song in the Main Tracklist, you will see additional ways of loading to decks and waitlists. There 
is also a command to Play Nest, which will load the song to the first available deck, and mix into that song from 
whatever is currently playing. Here is an image of the Main Tracklist context menu: 
 

 
 
 
 
To play a song you have loaded into a deck, either click the Play button, or use one of the Mix buttons. Mix Left, 
starts the song playing in Deck A, and starts the crossfader moving to the left, to fade into the song smoothly. Mix 
Right does the same to Deck B. The Mix Next button, will mix to whichever deck is not playing in the same 
fashion. 
 
You can also map shortcut keys to do this for you, and the default keyboard mapper shipped with Rockit is set to 
use F1 as Play Deck A, and F5 to Play Deck B. 
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Using the AutoMixer 
 
The AutoMixer will continuously load and mix songs from deck to deck for you. This is especially useful for playing 
dinner music and cocktail hour music. It has two modes; standard and random. Standard plays the songs you 
have put into the AutoMix Waitlist in order. Random mode, allows you to choose criteria, and let the software pick 
the songs for you. 
 
To try it out, drag and drop a few songs into the AutoMix Waitlist area, then simply click the AutoMix button as we 
have done here. The first song in the list loads to Deck A, and the crossfader automatically fades over as it starts 
the song. 
 

 
 
When the song in Deck A nears the end, the next song in the list will load to Deck B (the default time is 18 
seconds before the current song ends for the load). If using Level Mix Mode like above (the default), Rockit will 
start checking the output level 15 seconds before the song ends (adjustable), and wait until the level is below a 
certain threshold (also adjustable), then mix into the song in Deck B. All parameters are adjustable on the fly 
using the Settings button you see above. Level mix works great for songs that fade out at the end. 
 
You can also set the AutoMixer to use Timer Mode. In this mode, you set an exact time in seconds before the 
song ends, to start the mix. Timer mix works well for songs with hard endings. 
 
You can also adjust the speed of the auto-fader, to make the mix happen slower or faster. 
 
Experiment with different settings, and you will soon find out how the AutoMixer performs with different sets of 
songs or Playlists. Playlists can be dragged directly into the AutoMix Waitlist, or right-clicked and choose AutoMix 
Playlist to load the Playlist and automatically start the AutoMixer. 
 
If you right-click over the AutoMix Waitlist, you will find various options, such as Shuffle List, etc. 
 
You can manually override when the AutoMixer is on, in case a song is not working well, etc. For example, we 
have a song playing in Deck A, we drag a song into Deck B, click Mix Right, and it will mix into Deck B. You may 
need to manually stop the song in Deck A, although you won’t hear it playing after the mix. When the song in B 
nears the end, the AutoMixer will continue as normal. 
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Searching for Music 
 

 
 
Rockit has 3 different searches available; Search Library, Search Current List, and Extended Hard Drive Search. 
They work as follows: 
 
Search Library: Type in some text in the entry box, press ENTER, and the entire library will be searched, and all 
text fields are included (Title, Artist, Album, Genre and Year). The results will be displayed in the Search Results 
list if it is on the skin, if not, a window will popup with the results. This is by far the fastest search, and can display 
results in milliseconds, even on large libraries. 
 
Search Current List: Type some text in the entry box, press ENTER, and this will search the text fields of all 
tracks in the current list being displayed in the Main Tracklist. The results will be displayed in the Search Results 
list if it is on the skin, if not, a window will popup with the results. This is useful for searching Playlists with songs 
that might not be in the library. 
 
Extended Hard Drive Search: When you click on this button, a window will be displayed, allowing you to choose 
the drive to be searched, and enter the text to search for. This only searches the text of the filename, but can be 
very useful for songs you may have on an external drive, flash drive, etc. The initial search of a drive can take 
some time, but it runs in the background in its own thread. After the initial search it gets much faster, as much of 
the data then resides in cache memory, so you can do a dummy search before a show starts, in order to have 
that data cached for subsequent searches. 
 
Because this runs in the background, you can close this window while the search continues – when you open it 
up again, your results will be there. 
 
 
Important note regarding the Library Search: You can have songs in a Playlist, that are not in the library – they 
function independently of each other. So for example, if you added some songs to a Playlist, and did not add 
them to the library, the Library Search will not find them. So, best to always make sure all songs are in the library, 
in order for searches to be speedier and more accurate. 
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Watch Folders 
 
Watch Folders are an easy way to update your music library. You can add as many watch folders as you like, and 
periodically run a scan to update your library with any additions you may have made to those folders. 
 
When a watch folder is scanned, any folders underneath it are scanned as well, so there is no need to enter each 
folder separately. For example, I keep all music on my F Drive, under a folder called MP3. Under that, I have 
many subfolders, such as 60s Dance, 70s Classic Rock, Beach Music, etc. I only have to add the top level folder 
in order to have everything underneath it scanned, like so: 
 

 
 
 
Watch Folders are not setup to scan automatically, because it is resource intensive, and would slow down the 
startup operation of the software when doing a gig. You can access the above screen from the Tools menu, or 
directly from the Music Library Manager. 
 
You should do the scan after adding new music to your drive, but prior to a gig, to insure that your music library is 
up to date, and ready to rock. 
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Text Output 
 
Text Output is a new feature for V5. It allows you to connect to an external monitor/projector, and output logos as 
well as text. This is handy in bar environments, where you might post drink specials, announcements, etc. It can 
be set to also display the artist and title of the currently playing song. 
 
Click the Text Output button, or choose it from the View menu, and this screen will show: 
 

 
 
As you can see, there are numerous options available, and you can substitute your own logo for the stock one we 
provide (or use no logo), and change its position on the screen. Font and text colors can be changed at will, and 
are saved upon shutdown of Rockit, along with whatever display option you have chosen. 
 
If you are using one of the Current Song options, the song text is updated based upon the currently playing song 
being outputted to mains out. 
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Conclusion 
 
That’s it for this short getting started guide, it should get you up and running quickly. 
 
You can find much more information on our website on the Tutorials page, along with the full manual that goes 
into more detail. 
 
Happy Mixing ☺ 
 
 


